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1 INTRODUCTION 

1.1 ECFS 
The Electronic Comment Filing System (ECFS) is an Internet Web-based tool designed for the Federal 
Communications Commission (FCC or Commission) to give access to Commission rulemaking (RM) and 
docketed proceedings. ECFS allows you to research, retrieve, view and print any document in the system 
including previous non-electronic FCC documents that have been scanned into the system. ECFS includes 
data and images from the year 1992 onward. ECFS serves as the repository for official records in the 
FCC’s docketed and RM proceedings. 
 
The goals of ECFS are as follows: 
 
1. Provide the public with a simple electronic means to express and review opinions in docketed and 

rulemaking proceedings. 
2. Improve staff access to documents. 
3. Improve staff workflow. 
 
ECFS provides the general public with direct access to FCC documents from their own computer 
workstations. Access to ECFS is unrestricted so that anyone with Internet access can file and retrieve 
comments. Multiple users may view and access documents concurrently. 
 
ECFS users send or “upload” files via an Internet Web Browser. These files are typically word-processing 
documents containing comments in reference to a specific FCC Docket or RM proceeding. Users can also 
send comments via email (a computer readable form is submitted as part of email filings). Filers may also 
continue to send a paper filing (hard copy) instead, in accordance with existing rules, for inclusion in 
ECFS via FCC scanning. Virtually all documents are stored electronically and are available for search and 
retrieval via the Word Wide Web (WWW). Exceptions to this rule include a case in which the size of a 
document or certain types of media (video, microfiche, etc.) requires storing the document off-line. 
Confidential documents will not be available for the public to view. 
 
ECFS accepts files in the following formats: 
 
•  Microsoft Word 6.0 or higher 
•  WordPerfect 5.1 or higher 
•  ASCII Text 
•  Microsoft Excel 4.0 or higher 
•  Lotus 123 
•  Portable Document Format (PDF)* 

 
*preferred format 
 
Two types of reference materials are designed to familiarize you with the ECFS environment: 
 
•  User Manual: This manual is designed for individuals who have some basic knowledge of using the 

Internet. It focuses on tasks required for submitting and searching for filings(s). 
•  Online Help: Enables you to view procedural instructions on your monitor while you are using the 

ECFS application. 
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1.2 NOTES, TIPS, AND WARNINGS 
This manual contains a number of notes, tips and warnings that are designed to aid in your understanding 
of how the system works, to prevent unnecessary errors, and to help you save time.  Several of the notes, 
tips and warnings are listed below. 
 

Table 1-1. Note, Tips, and Warning Icons 

ICON NAME 

 Note/Tip 

 Warning 

 

 When using ECFS for the first time, you may wish to file your comments several business days 
before the comment period deadline. This will enable you to obtain filing assistance, if needed, and 
to ensure that your comments are filed in a timely fashion. 

 ECFS is accessible from http://www.fcc.gov/cgb/ecfs/welcome.html. It is recommended for users to  
create a bookmark of this page and other frequently visited web pages for each access. Refer to  
your Web Browser’s Help Menu for instructions on how to create a bookmark. 

 Test filings are permitted; however, the Office of the Secretary must be contacted prior to the 
submission at (202) 418-0300. 

 The filing deadline for email or electronic comments is before midnight EST. The filing deadline for 
hard copies (paper) is by 7:00 p.m. EST. In most cases, if ECFS is experiencing technical difficulties 
filing deadlines will be extended. 

 There is no specific turnaround time for placing filings on the Internet. Although electronic filings 
are generally placed quicker than hard copy/paper filings, processing could range from a few hours 
to approximately seven business days. 

 Please do not attach documents that are password protected, have redlined markings, macros enabled, 
formatted as read-only, or have automated links to source documents that are not included in your 
filing. Processing will be disrupted and your filing is subject to be rejected by ECFS, if the system 
detects these elements in your document. 

 MS Excel Workbooks that include multiple spreadsheets: Due to the conversion process that 
electronic submissions must undergo, the spreadsheets will display on ECFS as the last active sheet 
you viewed and saved before transmitting your Excel file to ECFS. 

 PDF documents: Although ECFS prefers documents to be submitted in PDF, you must remove all 
“Document Security” used to encrypt a document before attaching the file. 
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1.3 TECHNICAL SUPPORT 
If while working in ECFS you experience any problems or have questions related to ECFS, please contact 
ECFSHelp@fcc.gov or call (202) 418-0193. Technical support is available Monday through Friday, 8:00 
a.m. – 5:00 p.m. EST. You may also contact the FCC’s Reference Information Center at (202) 418-0270 
for general information concerning proceedings. If you are seeking guidelines on filing documents, 
contact the Office of the Secretary at (202) 418-0300. Of course, some problems may relate directly to 
your computer system and/or Web browser, then you should contact your Network Administrator or your 
Internet Service Provider. 
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2 ACCESSING ECFS 
This chapter explains how the user can access the ECFS web page from the Internet (WWW). A user 
must have access to a browser to file comments or perform queries. 
 
Software Requirements: In order to use ECFS, the user must have Netscape Navigator 3.0 or higher or 
Microsoft Internet Explorer 4.0 or higher.  Adobe Reader is also required in order to permit .pdf 
documents to be viewed. 
 

 Netscape Navigator 4.0+ is recommended because of its reliability. 

Following are the steps to access ECFS: 
 
1. Type http://www.fcc.gov on your website location to access the FCC Home Page URL. If you use 

FCC information frequently, you may want to bookmark one or more of the following sections 
mentioned in this manual. 

2. Select the E-Filing link located on the menu bar located at the top and bottom of the page. 

3. Scroll the list of FCC Electronic Filing & Public Access Systems to locate and select the Electronic 
Comment Filing System (ECFS) link. 

4. Select Submit a Filing to file a comment or select Search for Filed Comments to query the database 
for comments. 

 

 At the Commission, staff and public may access the ECFS web page from the Intranet. In an 
environment set up for the Reference Information Center, the public may access ECFS by using the 
Novell-delivered Applications for PUB1.public.FCC located on the PCs. Click the ECFS icon and 
the FCC ECFS Main Menu will display. FCC staff may access ECFS directly from the FCC Intranet 
Home Page by clicking on Information Center and selecting Databases then ECFS. 
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3 SUBMIT A FILING 
The two methods for submitting a filing are via the Internet through the ECFS website 
(http://www.fcc.gov/cgb/ecfs/welcome.html) or through email (ecfs@fcc.gov). 

3.1 FILING VIA THE WORLD WIDE WEB 
This process contains three phases: (1) Completing a cover sheet, and (2) Attaching documents or 
submitting typed comments, and (3) Receiving a Confirmation. 
 
Following the steps to access ECFS, the ECFS Home Page should be in view on your monitor. Click the 
Submit a Filing link from the ECFS Main Links section. 
 
The system will navigate you to the Electronic Comment File Submission web page. A Cover Sheet 
will appear. 
 
This section explains how to complete the cover sheet information prior to sending a comment to the 
FCC. Only some of the fields are required to be completed by the filer. The fields are labeled clearly and 
numbered for reference. In addition, the system allows a user to search for all docket and rulemaking 
(RM) numbers if it is not known at the time of the filing. Fields 1, 2, 3, 7, 8, 9, 10, and 12 are required 
fields and must be completed in order to process a comment. Subsequently, if all the fields including the 
relevant optional fields on the cover sheet are completed, comments will be processed more quickly and it 
will give a researcher more criteria to search/query a specific comment. No submissions can be filed 
against closed proceedings. 
 

 You can use the Tab key to navigate between the fields. 

3.2 COMPLETING A COVER SHEET 
 
1. Proceeding (required) 

Enter the Proceeding number. The proceeding number is either the unique assigned Docket Number 
or Rulemaking Number. Enter only the digits for a docketed proceeding, i.e. 00-221. For a 
Rulemaking Number use uppercase RM- followed by the digits, i.e. RM-9920. You may click on 
the underlined word Proceeding for a list of available Docket Numbers (DK#) or Rulemaking 
Numbers (RM). If you choose to click on the word “Proceeding,” follow the directions provided 
after doing so. 

  
2. Mail Correspondence To: (required) Name, Law Firm, Attorney 

Select one of the options by clicking on the radio button. 
  
3. Name of Applicant/Petitioner (required) 

Enter the name of the applicant or petitioner. This is the name of the filer. It is the actual applicant 
for a license, the petitioner of record or party represented, such as an individual, company/agency, 
etc. 

  
4. Law Firm Name 

Enter the name of the law firm. You may enter the name of the law firm or agency [optional] 
  
5. Attorney Name 

Enter the attorney’s name. You may enter the name of the filer’s attorney, the author of the 
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document or a contact person [optional] 
  
6. Email-id 

Enter your email address. Although it is optional to enter your email address, it will assist the FCC 
in notifying you if there is a technical or computer-related problem with your filing. 

  
7. Mailing Address for Correspondence (required) 

Enter the mailing address of the correspondence selected in field 2 (Mail Correspondence To). 
  
8. City (required) 

Enter the City of the correspondence selected in field 2 (Mail Correspondence To). 
  
9. State (required) 

Click on the ▼ (arrow) and select a state from the available list. 
  

 International filers choose “DC” in the state drop-down list box.   
  
10. Zip Code (required) 

Enter the zip code of the correspondence selected in field 2 (Mail Correspondence To). 
 

 International filers enter “00000” in the zip code field.    
 
11. Ex-Parte/Late Filed 

If the filing is late or an ex-parte filing, click the check box. 
 

 It is the filer’s responsibility to specify in the documentation submitted whether the comment being 
filed is ex-parte or late filed. 

  
12. Click on the ▼ (arrow) and select a document type from the available list. (required) 
 

 The most common document types used are Comment and Reply to Comments. Please do not 
select another type unless you are familiar with it and if it applies to your particular filing. 

  
13. Review your entries for accuracy. 
 
You now have completed the Cover Sheet. Click the “Clear Cover Sheet” button to reset the fields in the 
Cover Sheet. 
 

 If you are filing to more than one proceeding, you must complete a new Cover Sheet for each 
additional filing. 

3.3 ATTACHING A DOCUMENT 
Once you have completed the cover sheet, you must submit at least one comment. Your comments may 
be sent as an attached file or as text typed into the brief comment form. If you choose to send comments 
as an attached file you will complete the form directly below the cover sheet. Attaching a document 
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requires three steps (1) Confirm/Enter a file description, (2) Enter the path and name of the document, and 
(3) Select a file type.  We have attempted to minimize the burden on the user to complete this portion of 
the filing. The data fields in this section are automated to facilitate the process and ensure accuracy of 
data. You can attach only one document at a time. 
 
The preferred document format for submitting filings in ECFS is the portable document format (PDF). 
However, users can submit documents in MS Word, MS Excel, WordPerfect, Lotus, and American 
Standard Code for Information Interchange (ASCII) Text file formats. 
 
 

1. File Description 
The File Description will be populated with information based on your selection from field 12 on the 
Cover Sheet. If necessary, you may edit this information. 

  
2. File 

Enter the directory and file name to be attached. For example, if you saved your file on drive C and 
named it “97113fc.wp” then enter “C:\97113fc.wp” in the File field. Or use the “Browse…” button 
to help in locating your file. A File Upload window will appear. Locate your file using the Look in 
drop-down window or double clicking on folders displayed in the window. Once you have located 
your file, select it and click the “Open” button. 

  
3. Select one of these file types or convert your file to one of these 

Click on the ▼ (arrow) and select a file type. If the file type you used is not available, convert your 
file to one of the formats listed. 

  
4. Review information for accuracy. 
  
5. Send Attached File to FCC 

Click on the “Send Attached File to FCC” button. If an error message appears in a pop-up dialog 
box, click the “Ok” button and perform the recommended changes. If an error message appears 
again in a new page, click on the browser’s “Back” button and fix error(s) accordingly. Once the 
error(s) are corrected, click on the “Send Attached File to FCC” button to re-send. 

 

 Click the “Send Attached File to FCC” button once. If you click it more than once, the system may 
generate an error or the system will attach your document more than once. 

 
The system will navigate to page where you can continue or complete processing of your filing. 
  
6. Click the “Enter Additional Attachments” button if you have more than one attachment associated 

with your current filing. (For example, if you were sending a separate chart or if you divided your 
attachment into multiple parts such as Cover, Table of Contents, Summary, etc.) 

 If you are filing in more than one proceeding, you must first complete this filing. Complete a new 
Cover Sheet after you receive the confirmation for the sent comment submission. 

 
The system will return to the Send Comments to FCC (Attachments) window. Then repeat steps 1-5. 
 
-OR- 
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7. Click the “Finish Transaction and Receive Confirmation” button if you have completed attaching 
documents. 

3.4 SUBMITTING TYPED-IN COMMENTS 
ECFS also allows user to type in brief comments directly into a form on the Internet to send to the FCC. 
 

 Please include your name and address in the text of your brief comment. This will ensure that your 
comments are clearly identified if printed from ECFS. 

1. Press the ENTER key at the end of each line. If you wish to clear your comments and begin again 
click on the “Clear Comment” button to delete everything typed in the box. 

2. Click on the “Send Brief Comment to FCC” button to send your comment. If an error message 
appears in a pop-up dialog box, click the “Ok” button and perform the recommended changes. If an 
error message appears again in a new page, click on the browser’s “Back” button and fix error(s) 
accordingly. Once the error(s) are corrected, click on the “Send Brief Comment to FCC” button to 
re-send. 

3. The system will navigate to a screen where you can continue or complete processing of your filing. 

4. Click the “Enter Additional Attachments” button if you have more than one attachment associated 
with your current filing. (For example, if you were sending a separate chart or if you divided your 
attachment into multiple parts such as Cover, Table of Contents, Summary, etc.) 

 If you are filing in more than one proceeding, you must first complete this filing. Complete a new 
Cover Sheet after you receive the confirmation for the sent comment submission. 

The system will return to the Send Comments to FCC (typed-in) window. Then repeat steps 1-4. 

-OR- 

5. Click the “Finish Transaction and Receive Confirmation” button if you have associated all text and 
comments to your filing. 

 
The system will generate a confirmation page that will list details about your filing. It is recommended to 
print this page for reference in order to aid in researching the filing and troubleshooting problems 
associated with your filing. 
 

3.5 FINISHING THE COMMENT SUBMISSION 
This electronic confirmation informs you that the Federal Communications Commission (FCC) has 
received and accepted your filing. This receipt serves the same purpose as the Office of the Secretary’s 
stamp on a paper filing. 
 
You can click on the Initiate a Submission link to prepare another filing for a different proceeding or 
client. In addition, you can Search ECFS for comments or Return to the ECFS Home Page. Filings 
become available every business day, online, as they are disseminated. See Section 4.2 for instructions on 
finding comments in ECFS. 
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3.6 SENDING COMMENTS VIA EMAIL 
A second alternative in using ECFS is submitting comments via email. There are two options to 
submitting comments via email. For technical support contact the ECFS Help Desk at ecfshelp@fcc.gov 
or (202) 418-0193. 
 

 You cannot attach files with this option. You must enter the comments on the email form. 

 Please include your name and address in the text of your email filing. This will ensure that your 
comments are clearly identified if printed from ECFS. 

3.6.1 Option 1 
 
1. Click on the Email Filing Instructions link found on the ECFS Home Page. 

2. You may obtain a copy of the email form by clicking on the HERE 
(http://www.fcc.gov/cgb/ecfs/form-et.txt) link. 

3. Use the copy function by highlighting and copying all the tagged fields and placing them into a text 
editor program such as Notepad. 

 Because email filings are automatically processed, they must include specific ECFS Document 
Index Terms, and must be computer readable. To this end, FORM-ET includes Standard 
Generalized Markup Language (SGML) tags (similar to HyperText Markup Language (HTML) 
tags). 

4. Complete FORM-ET using Windows Notepad, any ASCII Text editor, or a word processing 
program that can save files as plain text. Fill in each line of the form by entering your specific 
information after each <TAG>. Do not remove or modify any of the tags. Type the body of your 
comment after the <TEXT> tag. 

 To ensure that your comments will be fully indexed, please complete as many of the tagged fields as 
possible. It is required that the following fields must be completed: <PROCEEDING>, <NAME>, 
<ADDRESS1>, <CITY>, <STATE>, <ZIP>, <DOCUMENT-TYPE>, and <TEXT>. 

5. Save the completed FORM-ET as an ASCII Text (plain text) formatted file. 

6. Copy the completed FORM-ET into the body of a new email message. 

7. Email the form to ecfs@fcc.gov. Please do not reply to ECFS messages. 
 
Email filers will be notified of receipt and either acceptance or rejection and any associated errors via 
email to the sender only as a reply. If once the email is received and processed any problems with your 
filing is detected you will be contacted at the email address listed in the <CONTACT-EMAIL> tag. 
 
3.6.2 Option 2 
 

 You cannot attach files with this option. You must enter the comments on the email form. 

 Please include your name and address in the text of your email filing. This will ensure that your 
comments are clearly identified if printed from ECFS. 
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1. You can request a copy of FORM-ET by sending a blank email message with the following words in 
the subject line or body of the message: 

Get Form <your email address> 

Example get form jsmith@domain.com 

2. You will receive in return a completed sample form and instructions on how to submit a comment 
using email, in addition to the actual form. Because email filings are automatically processed, they 
must include specific ECFS Document Index Terms, and must be computer readable. To this end, 
FORM-ET includes SGML tags (similar to HTML tags). 

3. Complete FORM-ET using Windows Notepad, any ASCII Text editor, or a word processing 
program that can save files as plain text. Fill in each line of the form by entering your specific 
information after each <TAG>. Do not remove or modify any of the tags. Type the body of your 
comment after the <TEXT> tag. 

 To ensure that your comments will be fully indexed, please complete as many of the tagged fields as 
possible. It is required that the following fields must be completed: <PROCEEDING>, <NAME>, 
<ADDRESS1>, <CITY>, <STATE>, <ZIP>, <DOCUMENT-TYPE>, and <TEXT>. 

4. Save the completed FORM-ET as an ASCII Text (plain text) formatted file. 

5. Copy the completed FORM-ET into the body of a new email message. 

6. Email the form to ecfs@fcc.gov. Please do not reply to ECFS messages. 
 
Email filers will be notified of receipt and either acceptance or rejection and any associated errors via 
email to the sender only as a reply. If once the email is received and processed any problems with your 
filing is detected you will be contacted at the email address listed in the <CONTACT-EMAIL> tag. 
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4 SEARCH FOR FILED COMMENTS 
ECFS allows users to query the database for specific proceedings filed within the system. Based on 
specific criteria, users can limit or broaden search results. Fewer criterions will produce more results; 
more criteria will produce fewer results. In other words, the more fields you complete the fewer records 
you will retrieve. The fewer fields you complete the more records you will retrieve. In addition, users are 
encouraged to utilize the FCC’s other search engines for items not contained within ECFS.   
 

4.1 LOCATING A PROCEEDING NUMBER 
If you do not know the proceeding number at the time of filing or searching, you can locate a proceeding 
number in just a few minutes from the Search for Filed Comments page. 
 
1. Click on the Proceeding link in field #1. 

The system will navigate you to a search screen to locate a docket or RM number. Follow the directions 
provided after accessing the Search for Proceedings screen. 

2. You may confirm the accuracy of the Docket or RM number. Type in a numeral, RM, or a 
combination of both that represents the number of the targeted proceeding (e.g. 99, 217, RM-88, 
etc.) 

 By typing an asterisk (*) in the box, the system will retrieve all proceedings stored in ECFS. You 
may search the list to determine the subject by using the Find In Page Search window from the 
toolbar. Select the drop down menu from Edit. 

3. Click the “Search For Proceedings” button. 

The system will display all dockets and RMs associated with the data entered in Step 2. The docket/RM 
numbers will be represented as a link and will include a description of each. Browse through the list to 
locate your desired proceeding. 

4. Click on the Enter More Criteria link next to the desired proceeding number. 

The system will return to the Cover Sheet with the proceeding number populated in field 1 and the title 
displayed below it. 

 Once returned to the Search for Filed Comments page, Proceeding will no longer be displayed as a 
link. However, the system generates another link Select a different Proceeding for you to click on 
and perform another search if the proceeding listed in field 1 is incorrect. 

4.2 PERFORMING A SEARCH 
Although you can use any or all fields to retrieve comments, it is recommended that your search is 
restricted to only a few fields (i.e. Proceeding and/or Date Submitted). You have the ability to perform 
“wildcard” searches using the percent (%) symbol in fields 5 – 7, 9 (Filed on Behalf of, Law Firm, 
Attorney Name, and File Number/Community). This is useful when you are uncertain of the spelling 
or know only part of the information such as a person’s last name. You can use the Tab key to navigate 
between fields. You can click the “Clear” button to remove data from all the fields. 
 
From the ECFS Home Page, click on the third link Search for Filed Comments in the ECFS Main Links 
section. 
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1. Proceeding 
Enter the docket or rulemaking number. Enter only the digits for a docketed proceeding, i.e. 00-
221. For a Rulemaking Number use the uppercase RM- followed by the digits, i.e. RM-9920. It 
should also be noted that you might search for a proposed rulemaking stored in ECFS by using the 
year and designated bureau with PRM, i.e. PRM01WT.  Enter PRM00MM, PRM02MM, 
PRM01ET, etc. 

  
2. Date Submitted 

Enter the date of the submission. This is the date that a public filing is either (1) officially received 
at the Commission, (2) officially adopted by the Commission, or (3) officially issued by the 
Commission. Enter the date in the format as follows: mm/dd/yyyy. 

  
3. DA/FCC Number 

Enter the specific FCC or DA number. This is a unique number assigned to various Commission 
action documents. For a DA number enter DA followed by the numerical characters, i.e. DA 00-
1673. For a FCC number enter only the numerical characters, i.e. 00-395. DA/FCC numbers will 
only be available on ECFS if also assigned to a Docket or Rulemaking Number. 

 

 To perform a general search for DA or FCC number, you may wish to use the Electronic Document 
Management System search engine. 

  
4. Click on the ▼ (arrow) and select an abbreviation of the document type that accurately describes the 

document you are searching. This is a unique code assigned to the document. The complete list is 
available by clicking on the Document Type link. 

  
5. Filed on Behalf Of 

Enter the applicant or petitioner’s name. This is the actual applicant for a license, the petitioner of 
the record or party represented, such as an individual or company/agency, etc. If uncertain, use 
enough characters to make the search criteria unique or use the “wildcard” (%). 

  
6. Law Firm 

Enter the name of the law firm. You can use the “wildcard” (%) search, or partial spelling to ensure 
that any variation in spelling will not limit the results. 

  
7. Attorney Name 

Enter the name of the filer’s attorney, the author of the document, or contact person. You can enter 
a “wildcard” (%) search, first name, last name, or partial spelling to ensure that any variation in 
spelling will not limit the results. 

  
8. Document Date 

Enter the document date. This is the date of the filed document indicated on the filing or cover 
sheet. The filer provides this date. Enter the date in the format as follows: mm/dd/yyyy. 

  
9. File Number/Community 

Enter the unique file number, report number, documents submitted in a mass mailing, or the city 
and state for petitions for rulemaking filed in table of allotments proceedings. You can use a 
“wildcard” (%) search, or partial spelling to ensure that any variation in spelling will not limit the 
results. 

  
10. Date Released/Denied 
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Enter the date released or denied. This is the date a Commission originated document was released 
or the date a petition for rulemaking was denied. Enter the date in the format as follows: 
mm/dd/yyyy. 

  
11. Ex-Parte/Late Filed 

Select the checkbox to retrieve all documents designated as either Ex-Parte or Late Filed. Most 
documents will have a Document Type of NOTICE (NO). 

  
12. City 

Enter the city of the filer, law firm or attorney. 
  
13. State 

Click on the ▼ (arrow) and select the state of the filer, law firm, or attorney. 
  
14. Zip Code 

Enter the zip code of the filer, law firm or attorney. 
  
15. Review data for accuracy. 
  
16. Click the “Retrieve Document List” button. 
 
The system will display the “Search Result Set” which will show how many documents were found that 
met your search criteria and are available for viewing. In each result box, a Proceeding No., Type code, 
Date Received/ Adopted, Date Released/Denied, Document Type, total pages, File Number/Community, 
DA/FCC Number, Filed on Behalf of, Filed By, Attorney/Author Name, and Complete Mailing Address 
will be displayed, if applicable. To read a specific comment, click on the appropriate buttons labeled with 
document types such as COMMENT, REPLY, etc., (generally for electronic submissions), View (for 
scanned documents), or they may be labeled with page ranges (for documents migrated from the original 
imaging system in 1998). 
 

 The date reported in ECFS should reflect the information available on the actual filing. However 
occasionally our effort to provide excellent service may yield to human error. We appreciate and 
welcome your feedback to correct any discrepancies you may find on ECFS. Please report the 
information to the ECFS Help Desk at ecfshelp@fcc.gov. 

 The most recently disseminated documents appear at the top of the list. 

The search results list will be displayed in divisions of 10, 20 or 100 records respectively if the number of 
records retrieved is greater than 10, 400, or 1000. The system will exhibit the search results list and will 
display the document links. If a docket is associated with a RM and that docket is queried, the result will 
display document information for both the docket and the consolidated RMs (e.g. docket 98-154 is 
associated with RM-9174. If the docket number 98-154 is queried the RM-9174 will be listed with the 
docket number in the result set). 
 
If a search is performed on a closed and consolidated RM, the system will inform you that the RM is 
closed and refer you to any docket(s) under which it was consolidated. You can enter the associated 
docket number in field 1 on the form and any additional search criteria. 
 
If the rulemaking is open, the search result list will display document information for the RM only. 
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4.2.1 Using Wildcards 
 
To perform a search using wildcards enter the percent sign (%) at the beginning and ending of the search 
string in place of the missing text in the desired field (e.g. Sprint Communications can be typed as “%rint 
Commun%” in the Filed on Behalf of field). This search string would only retrieve document(s) from the 
database that has the string “ring Commun” contained within the applicant name. You can use wildcards 
for Filed on Behalf of, Law Firm, Attorney Name, File Number/Community, and City fields. 
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5 SEARCH FOR A PROCEEDING HISTORY 
A Docket History is the chronological listing of all documents received or issued by the Commission in a 
particular proceeding. The documents listed in the History are routine filings. They may be unrestricted or 
restricted for viewing purposes, and they also may be confidential, or “Not Available for Public 
Inspection.” Docket Histories were historically typewritten on index cards. The Cards summarizing the 
histories of proceedings for the period 1934 through 1984 are available for inspection in the Reference 
Information Center, CY-A257, 445 12th Street, SW, Washington, DC (The Portals). 
 
The ECFS History for several proceedings lists a document type called “Other.” When “Other History 
Cards” is the document type on a History, it is an indication that an index card was scanned into the ECFS 
system and is available as an image. When “Other History Cards” is the document type, you may view the 
entire record by going to the query form to search for filed comments. The records will also indicate two 
other Docket History document subsets of “Other.” A second subset of “Other” is called “History.” 
 
The “History” subset of “Other” indicates a history which was initiated before 1992 and was formerly 
known as “Pre-RIPS” before the ECFS system was put into production. These have been scanned into 
ECFS.  The Document type for these histories is shown as “Other History.” These records may also be 
viewed by navigating to the query form, and searching for filed comments. 
 
To search for ECFS Proceeding History Reports click on the Search for a Proceeding History link located 
in the ECFS Main Links section. 
 

5.1 LOCATING A PROCEEDING NUMBER 
If you do not know the proceeding number, you can locate a proceeding number in just a few minutes 
from the ECFS Proceeding History Report page. 
 
1. Click on the Proceeding link in field #1. 

The system will navigate you to a search screen to locate a docket or RM number. Follow the directions 
provided after accessing the Search for Proceedings screen. 

2. You may confirm the accuracy of the Docket or RM number. Type in a numeral, RM, or a 
combination of both that represents the number of the targeted proceeding (e.g. 99, 217, RM-88, 
etc.) 

 By typing an asterisk (*) in the box, the system will retrieve all proceedings stored in ECFS. You 
may search the list to determine the subject by using the Find In Page Search window form the 
toolbar. Select the drop down menu from Edit. 

3. Click the “Search For Proceedings” button. 

The system will display all dockets and RMs associated with the data entered in Step 2. The docket/RM 
numbers will be represented as a link and will include a description of each. Browse through the list to 
locate your desired proceeding. 

4. Click on the desired proceeding link. 
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5.2 RETRIEVING PROCEEDING HISTORY REPORTS 

1. Click in the first text box and type in the docket or rulemaking number. Enter only the digits for a 
docketed proceeding, i.e. 00-221. For a Rulemaking Number use the uppercase RM- followed by 
the digits, i.e. RM-9920. 

2. Click the “Retrieve” button. The system will list all records for the proceeding in a result set. 

 Generally the Viewing Status indicated for each document listed on the history is Unrestricted (10). 
However, you will also find Viewing Status for documents as Correspondence (20), Confidential 
(30), and Sunshine (40). The confidential filings (30) are not available for public inspection. 

-OR- 

3. If you are interested in a particular date range, tab to the second text box and enter a start date and 
tab to the third text box and enter an ending date. Enter the date as specified (mm/dd/yyyy). Then 
click the “Retrieve” button. The system will list the number of records for that date range found of 
the total number of records for the proceeding. 

 
The result set will include all consolidated proceedings. If a docket is associated with a RM and that 
docket is queried, the result set will display document information for both the docket and the 
consolidated RMs. 
 
If a query is performed on a closed and consolidated RM, the system will inform the user that the RM is 
close and any docket(s) under which it was consolidated will be listed. 
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6 BATCH PRINTING 
The batch-printing feature is available to both the staff and public from within the FCC. Users gain access 
via the Commission’s Intranet web site. Public users are welcome to visit the Reference Information 
Center (RIC) located in Room CY-A257 at the Commission’s Headquarters. It is open to the public 
Monday through Thursday from 8:00 a.m. to 4:30 p.m. and from 8:00 a.m. to 11:30 a.m. on Friday. The 
RIC has public computer workstations available for use. 
 

 In addition to the Batch Printing, you may print a document directly to your local or network printer.  
Click on File and choose the Print option.  You may print an entire comment document by choosing 
All Pages or any part of the comment by choosing the Current Page(s).  Once you have made your 
selection, click OK to print. 

  
The public may access ECFS by using the Novell-delivered Applications for PUB1.public.FCC located 
on the PCs. Click the ECFS icon and the FCC ECFS Main Menu will display. FCC staff may access 
ECFS directly from the FCC Intranet Home Page by clicking on Information Center and selecting 
Databases then ECFS. 
 

 Public users direct their print job(s) to the Commission’s Copy Contractor, located in room CY-
B402. Make sure to provide them with the job ID number to ensure receipt of the correct documents. 

 FCC staff must retrieve their print job(s) from the designated printer. We suggest that staff ensure 
that the paper supply in the printers is sufficient to complete the print request. For problems with 
ECFS printers, contact the Help Desk at (202) 418-0193. 

 

6.1 PRINTING A DOCUMENT 

1. Click on the Print a Document link found on the frame or the web page. The system will navigate 
to the Document Report Print Request Form. 

 To complete the form you must select a year, proceeding type, and the actual documents you wish to 
have printed. The RM link indicates Rulemaking numbers. The PR link indicates newly filed 
Petitions for Rulemaking. 

 If printing most of the documents in a proceeding, you may click on “Print a Docket/RM.”  There 
you can deselect the documents you do not wish to print and only print those that you want.   

2. Click on the desired year or the proceeding type. 

3. Choose a proceeding for the available list. 

4. Select a document by clicking on the box. If you plan to select several documents to print, you can 
distribute your print jobs to more than one printer for a faster result. 

5. Click on the ▼ (arrow) and select a printer. Public users have a choice of two printers located in 
Room CY-B402 (Copy Contractor).  Staff users have a choice of several printers conveniently 
located throughout the Commission. 

6. Click on the “Enter These Print Requests” button. 
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7. Click on the Print link to commit the print request. The system will navigate to a page with your 
print job ID number. Please note the number for reference. 

-OR- 

8. Click on the Modify link to change your selection. When completed, click on the “Modify These 
Print Requests” button. Continue with step 7 to complete the request. 

-OR- 

9. Click on the Cancel link to delete the print job. 
 

6.2 PRINTING A DOCKET OR RULEMAKING 

1. Click on the Print a Docket/RM link found on the frame or the web page. The system will 
navigate to the Document Report Print Request Form. 

 To complete the form you must select a year, proceeding type, and the actual documents you wish to 
have printed. The RM link indicates Rulemaking numbers. The PR link indicates newly filed 
Petitions for Rulemaking. 

 If printing a few documents in a proceeding, you may click on “Print a Document.”  There you can  
select the documents you wish to print. 

2. Click on the desired year or the proceeding type. 

3. Choose a proceeding for the available list. 

4. Select a document by clicking on the box. If you plant to select several documents to print, you can 
distribute your print jobs to more than one printer for a faster result. 

5. Click on the ▼ (arrow) and select a printer. Public users have a choice of two printers located in 
Room CY-B402 (Copy Contractor). Staff users have a choice of several printers conveniently 
located throughout the Commission. 

6. Click on the “Enter These Print Requests” button. 

7. Click on the Print link to commit the print request. The system will navigate to a page with your 
print job ID number. Either make note of the number or print the page, if applicable, for reference. 

-OR- 

8. Click on the Modify link to change your selection. When completed, click on the “Modify These 
Print Requests” button. Continue with step 7 to complete the request. 

-OR- 

9. Click on the Cancel link to delete the print job. 
 

6.3 PRINTING A PROCEEDING HISTORY 

1. Click on the Print a Proceeding History link found on the frame or the web page. The system will 
navigate to the Document Report Print Request Form. 
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 To complete the form you must select a year and proceeding type you wish to have printed. The RM 
link indicates Rulemaking numbers. The PR link indicates newly filed Petitions for Rulemaking. 

2. Click on the desired year or the proceeding type. 

3. Choose a proceeding for the available list. 

4. Click on the ▼ (arrow) and select a printer. Public users have a choice of two printers located in 
Room CY-B402 (Copy Contractor). Staff users have a choice of several printers conveniently 
located throughout the Commission. 

5. Click on the “Enter These Print Requests” button. 

6. Click on the Print link to commit the print request. The system will navigate to a page with your 
print job ID number. Either make note of the number or print the page, if applicable, for reference. 

-OR- 

7. Click on the Cancel link to delete the print job. 
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7 USING THE ADOBE ACROBAT READER 
 
This chapter provides instructions on displaying Portable Document Format (PDF) comments using the 
Adobe Acrobat Reader.  
 

7.1 DISPLAYING COMMENTS 
The Adobe Acrobat Reader (AAR) is required to display comments that are stored as PDF files. The AAR 
and installation instructions are available free of charge at the Adobe site (http://www.adobe.com).  
Please refer to your web browser for instructions to configure a “helper” or plug-in application, if the 
“Unknown File Type” message is displayed when you attempt to view a PDF file. 
 
ECFS Documents are available in two versions scanned or editable electronic format. Users have the 
ability to search for words or phrases in the editable version, whereas the scanned versions is not available 
for word/phrase searches.  To learn more about finding words or phrases in documents, refer to Section 
6.2. 
 
After you have configured the browser to work with PDF files, you will have several options to view the 
pages of the document: click on any of the page # buttons on the search screen, click on the scroll bar on 
the right of the screen, or click on the <Previous Page or Next Page> buttons at the top of the screen.   

 After you have finished reading the correct document, minimize the AAR instead of closing it, to 
ensure that it will already be open if you need to view other documents later. 

7.2 FINDING WORDS WITHIN COMMENTS 
Comments to the Commission are submitted electronically or via paper. Documents which are received 
electronically upon dissemination are automatically added to the database and provide many additional 
benefits for research.  Electronic documents support word search, cut and paste, and other functions.  
Paper filings are scanned into the ECFS system. Scanned documents are only pictures of the pages and 
have the ability to be reviewed but not manipulated. Like photocopies, the text cannot be modified or 
searched. The file size of the scanned documents is larger than the file size of the electronic documents, 
so they will download slower than an electronic document. The scanned documents may be located using 
the search techniques described in Section 4.2. The advanced searching described in the rest of this 
chapter, however, cannot be applied to scanned documents. 
 
If a document was submitted electronically, you can use the “Find Word” option to find words or a phrase 
within a comment. However, if a document was submitted via paper, the “Find Word” option will not 
work. To search for words within the comment, select the Edit and Find or the binocular icon (Find 
Word). You can use any or all three options. The “Match Whole Word Only” option searches for the 
word that is identical to the word that you entered. For example, if you enter the word “support,” it will 
not locate the word “supporting.” “Match Case” is case sensitive; therefore, it will only locate words that 
are exactly the same in terms of lower or upper case as you have entered (For example, if you enter the 
word “REPLY” it would not locate words such as “Reply” or “reply.”). The last option is “Find 
Backwards,” which allows you to search from the current page backward. 
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7.3 COPYING AND PASTING COMMENTS 
 
You may copy and paste comments into the windows Clipboard, or word processors by performing the 
following steps: 
 
1. Select Text Select Tool or Graphics Select Tool from the toolbar menu.  Click and drag the mouse 

to highlight the text/graphic that you want to copy.   
 

 There are some scanned documents which you must use the Graphics Select Tool option since the 
pages are images not text.  You also may want to adjust the size before copying because you will not 
be able to enlarge the font size after you have pasted the image of the text. 

 
2. Select Copy in the Edit menu or the Copy icon on the toolbar of the Acrobat browser plug-in to copy 

the selected text/graphic. 
 
3. Select Show Clipboard in the Window menu to view your selected text/graphic.  You may save your 

selected text/graphic using the Save As option in the File Menu, or paste into any word processor.  
 

7.4 SAVING COMMENTS 
 
You may save the entire document or part of the document to your hard disk by doing the following: 
 
1. Choose Save As under the File menu to save the entire document. For partial documents, choose Text 

Select Tool or Graphics Select Tool under the Tool menu, and highlight the text or graphic. 
 
2. Go to Edit and select Copy.  Paste your selection into your processor (i.e. MS Word, WP etc.) by 

choosing Paste under the Edit menu. 
 
3. To save, choose Save As in the File menu. 

 
Alternately, you could break up the PDF document into smaller PDF documents and mix and match the 
pages with other PDF documents.  See the Acrobat help files for instructions on the page handling 
capabilities of the Acrobat product that you are using. 
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APPENDIX A: VALID DOCUMENT TYPES 
 
ABBREVIATION FILING TYPE 
AI ANSWER TO INTERROGATORY 
AL APPEAL 
AM AMENDMENT 
AP APPLICATION 
AR APPLICATION FOR REVIEW 
CL COMPLAINT 
CO COMMENT 
CP COUNTERPROPOSAL 
CT CORRECTION TO TRANSCRIPT 
DC DIRECT CASES 
DE DECISION 
DN DECLARATION OF NO CONSIDERATION 
DO DESIGNATION ORDER 
DP DEPOSITION 
EC EXCEPTION 
ER ERRATA, ERRATUM, & ADDENDUM 
ET ORDER GRANTING EXTENSION OF TIME 
EX EXHIBIT 
FI FURTHER NOTICE OF INQUIRY 
FN FURTHER NOTICE OF PROPOSED RULEMAKING 
HD HEARING DESIGNATION ORDER 
ID INITIAL DECISION 
IO INTERROGATORY 
IS INTEGRATION STATEMENT 
LF LICENSE FILE 
LT LETTER 
MA MEMORANDUM OPINION & AUTHORIZATION 
MN MOTION 
MN MOTION FOR EXTENSION OF TIME 
MN  MOTION FOR PRODUCTION OF DOCUMENTS 
MN MOTION FOR PROTECTIVE OR CLARIFYING ORDER 
MN MOTION FOR SUMMARY DECISION 
MN MOTION TO ACCEPT LATE-FILED COMMENTS 
MN MOTION TO COMPEL 
MN  MOTION TO DISMISS 
MN MOTION TO ENLARGE ISSUE 
MN MOTION TO QUASH 
MN MOTION TO REOPEN THE RECORD 
MN MOTION TO STRIKE 
MN MOTION TO SUSPEND PROCEDURAL DATES 
MN PRODUCTION OF DOCUMENTS 
MN STRIKE 
MO MEMORANDUM OPINION & ORDER 
NA APPEARANCE 
NA NOTICE OF APPEARANCE 
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ABBREVIATION FILING TYPE 
NC CHANGE OF ADDRESS 
NC NOTICE OF CHANGE OF ADDRESS 
ND NOTICE OF DEPOSITION 
NI INQUIRY 
NI NOTICE OF INQUIRY 
NO INTENT TO PARITICIPATE IN ORAL ARGUMENT 
NO NOTICE 
NO NOTICE OF INTENT TO PARTICIPATE IN ORAL ARGUMENT  
NO NOTICE OF INTENT TO TAKE DEPOSITION 
NO NOTICE OF PRE-HEARING CONFERENCE 
NP NOTICE OF PROPOSED RULEMAKING 
NP PROPOSED RULEMAKING 
NW NOTIFICATION OF WITNESS 
OA ORDER & AUTHORIZATION 
OC ORDER, AUTHORIZATION & CERTIFICATE 
OD DENIAL OF EXTENTION OF TIME 
OD ORDER DENYING EXTENSION OF TIME 
OI DESIGNATION ISSUES 
OI ORDER DESIGNATING ISSUES FOR INVESTIGATION 
ON ORDER ON RECONSIDERATION 
OO OPINION AND ORDER 
OP OPPOSITION 
OP OPPOSITION TO ANSWERS TO INTERROGATORIES 
OP OPPOSITION TO COMPEL 
OP OPPOSITION TO MOTION FOR PRODUCTION OF DOCUMENTS 
OP OPPOSITION TO MOTION FOR PRODUCTION OF DOCUMENTS  
OP OPPOSITION TO MOTION FOR PROTECTIVE OR CLARIFYING 
OP OPPOSITION TO MOTION TO COMPEL 
OP OPPOSITION TO MOTION TO STRIKE 
OP OPPOSITION TO NOTICE OF DEPOSITION UPON ORAL EXAMI 
OP OPPOSITION TO NOTICE OF DEPOSITION(S) 
OP OPPOSITION TO PETITION FOR RECONSIDERATION 
OP PARTIAL OPPOSITION 
OR ORDER 
OS ORDER STAYING FILING WINDOW 
OS STAYING FILING WINDOW 
OT OTHER 
PF PROPOSED FINDINGS/REPLY FINDINGS 
PL  LEAVE TO AMEND 
PL PETITION FOR LEAVE TO AMEND 
PN PUBLIC NOTICE 
PO PREHEARING ORDER 
PP PROOF OF PUBLICATION 
PR PETITION FOR RECONSIDERATION 
PT PETITION 
PU PETITION FOR RULEMAKING 
PU RULEMAKING 
PV PETITION FOR REVIEW 
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ABBREVIATION FILING TYPE 
PW PETITION FOR WAIVER 
PW WAIVER 
RC REPLY TO COMMENTS 
RE  RECONSIDERATION 
RL REPLY 
RN RETURN RECEIPT 
RO REPORT & ORDER 
RP REPLY TO PETITION FOR RECONSIDERATION 
RQ JOINT REQUEST FOR APPROVAL OF SETTLEMENT 
RQ REQUEST 
RQ REQUEST FOR APPROVAL OF SETTLEMENT 
RQ REQUEST FOR EXTENSION OF TIME 
RQ REQUEST FOR ORAL ARGUMENT 
RQ REQUEST FOR SUPPLEMENTAL INFORMATION 
RR REPLY TO OPPOSITION(S) TO PETITION FOR RECONSIDERA 
RT  REPORT 
RT SUBMISSION OF REPORT 
SC ORDER TO SHOW CAUSE & HEARING DESIGNATION ORDER 
SC SHOW CAUSE 
SD SUMMARY DECISION 
SP SUPPLEMENT 
SR SUBMISSION FOR THE RECORD 
ST STATEMENT 
ST STATEMENT FOR THE RECORD 
SU SUBPOENA 
TD TENTATIVE DECISION 
TR  TRANSCRIPT 
TS TESTIMONY 
WD NOTICE OF WITHDRAWAL OF COUNSEL 
WD WITHDRAWAL 
WD WITHDRAWAL OF COUNSEL 
 


